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INTRODUCTION
One of the advanced features of your Digital DrivePLUS subwoofer is the available options for optimizing the bass output, including Self-EQ,

Auto-EQPLUS and Manual-EQ. You can use all the optimization methods, except Manual-EQ, without either of the user interfaces for Digital

DrivePLUS optimization. However, if you want to use Manual-EQ optimization you need to use one of the user interfaces. Also, if you want to

view your subwoofer’s frequency response and/or parameter settings, you need to use a user interface.

Refer to the Digital DrivePLUS User’s Manual for information about the Self-EQ, Auto-EQPLUS and Manual-EQ optimization methods and the

parameters each optimizes, descriptions of the parameters that can be optimized manually, and a recommended order to adjust parameters

during Manual-EQ optimization.  

For your convenience, Velodyne provides the following two user interfaces for performing optimizations:

• Velodyne’s Digital DrivePLUS Windows Setup Program: (Velodyne recommended interface) Software that runs on a Windows

computer. This program is sometimes referred to by the shorter name of Windows interface. The software is used to:

- Control and display preset EQ and parametric filter settings

- Initiate Self-EQ, Auto-EQPLUS and Manual-EQ optimizations

- Display the subwoofer’s frequency response curve

- Display the parametric filter curves

- Save and open Digital DrivePLUS files with subwoofer’s settings and for Manual-EQ only, the frequency response

curve that results from these settings

- Save settings to the subwoofer’s memory 

• TV Screen Display and Remote Control Commands: This combination is often referred to by the shorter name of

TV Screen interface because settings and command choices are shown on your TV screen. The TV screen interface and

remote control can be used together to:

- Control and display preset EQ and parametric filter settings

- Initiate Self-EQ, Auto-EQPLUS and Manual-EQ optimizations

- Display the subwoofer’s frequency response curve

- Display the parametric filter curves

- Save settings to the subwoofer’s memory

MANUAL ORGANIZATION
You need to only use one interface for optimization or viewing of settings and frequency response curves. We recommend the Windows

interface as it is usually much easier to connect your subwoofer to your computer than to your TV screen. Also, the Windows interface

allows you to see the parametric filter curves and save settings to files on your computer. These features aren’t available with the TV

screen interface. Because you only need to use one interface, skip to the part of this manual that covers the interface you want to use:

• Part One - Windows User Interface for Optimization (Recommended Interface)

OR

• Part Two - TV Screen User Interface for Optimization

The final part of this manual covers how to update the driver, software, bootcode and firmware.

• Part Three - Software & Driver Updates
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PART ONE -  
Windows Interface for Optimization 

(Recommended Interface)

In order to use the Windows interface to perform any setup or optimization of your Digital DrivePLUS subwoofer, the following two programs

need to be installed on your computer:

• USB Virtual COM Port Driver

• Velodyne’s Digital DrivePLUS Windows Setup Program 

Both pieces of software can be fully uninstalled using normal Windows procedures as described later in this document, leaving your

computer in its former state.

This part of this document covers:

• The purpose of the driver and program.

• The computer requirements for installing this driver and program.

• How to install and uninstall this driver and program.

• How to connect your subwoofer and the Windows Setup Program so that they communicate and share data.

• How to troubleshoot connection issues between your subwoofer and the Windows Setup Program.

• How to use the Windows Setup Program controls to modify and save subwoofer parameters.

• How to run Self-EQ and Auto-EQPLUS optimization using the Windows Setup Program.

• How to use the Windows Setup Program to perform Manual-EQ optimization. 

• How to update the USB Virtual COM Port driver, the Velodyne Digital DrivePLUS Windows Setup Program, the Velodyne

Digital DrivePLUS subwoofer bootcode and the Velodyne Digital DrivePLUS subwoofer firmware.

CAUTION:  Since the DD+ subwoofer is a USB device, there is more to connecting the subwoofer to your PC than simply installing the USB

cable. You should always connect the subwoofer to the PC right after running the Velodyne Digital DrivePLUS Windows Setup Program CD

to allow Windows to recognize the subwoofer and complete driver configuration and installation.

Virtual COM Port Driver

The USB Virtual COM Port driver allows the Digital DrivePLUS subwoofer to appear as though it was connected through a COM port even

though it connects with a USB port. The Digital DrivePLUS subwoofer communicates usually through a COM port, such as the two RS-232

connectors on the back of your subwoofer. Because most modern computers have USB ports instead of COM ports, you need to convert

one of your computer’s USB ports to a COM port. Instead of having to physically perform this conversion with hardware, you can use the

USB Virtual COM Port driver to virtually perform the conversion.

Velodyne’s Digital DrivePLUS Windows Setup Software 

Velodyne’s Digital DrivePLUS Windows Setup Software is the Windows computer interface for adjusting your subwoofer’s parameters.

This interface displays the same information and allows for the same parameter adjustments as the TV screen interface. However,

with this interface you don’t need to access the video input connections to your TV that are often hard to reach in an already installed

home theater system.
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Software Installation Requirements

The USB Virtual COM Port software and Velodyne’s Digital DrivePLUS Windows Setup software require the Windows operating systems

and minimum hardware as shown in the table below.

Windows Setup Software and USB Driver 

Minimum Hardware and Operating System Requirements

32-bit and 64-bit Home and Professional versions of:

Supported Windows XP SP2

Operating Systems Vista SP1

Windows 7

RAM (Memory) 1 GB RAM

Processor Speed 1 GHz single core

Available Hard Drive Space 5 MB

Display Resolution 800 x 600

Note: Velodyne’s Digital DrivePLUS Windows Setup software was not designed to operate in any Mac, Linux, or virtual machine operating

systems. Often in virtual machine operating systems, such as VM Ware and Parallels for Mac, the operating system can’t recognize devices

connected to the computer’s USB and COM ports. Hence, your computer can’t communicate with the Digital DrivePLUS subwoofer from within

a virtual machine.

Installing the USB Virtual COM Driver and the Digital DrivePLUS Windows Setup Program

The Velodyne Digital DrivePLUS Windows Setup Program CD is designed to perform the installation of both the USB Virtual COM driver and the

Digital DrivePLUS Windows Setup Program with minimal user guidance. However, for the Digital DrivePLUS Windows Setup Program you can

choose your installation language and the location to install the software. 

To install the driver and software:

The images included in this procedure are from an installation done on a Windows 7 computer. Due to differences in the various Windows

operating systems, your install experience may vary slightly from the one presented here. 

1) Make sure your computer is on and that you can see your Windows desktop. The subwoofer should NOT be connected to

the subwoofer yet.

2) Save your work and close running application programs, open browser windows and other open screens.

3) Insert the Velodyne Digital DrivePLUS Windows Setup Program CD into your computer’s compatible disc drive.

4) The disc auto plays and begins installing the USB Virtual COM Port driver. It may take up to 10 seconds for the auto play

to begin depending on your computer.
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5) In Windows 7, if you see an AutoPlay dialog window as shown below, click Run VelodyneDD+Setup_v###.exe under

the text that reads “Install or run program from your media.”

If the install program doesn’t start automatically, you can start the installation by double-clicking on the VelodyneDD+Setup_v###.exe file in

the CD directory in Windows Explorer as shown below. ### represents the version number of the software, such as 100.

[ 4 ]
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6) The driver install is performed in a black background command prompt window. It begins by displaying the echo off message as

shown below.

7) The driver install can take anywhere from a few seconds to a few minutes, depending on the configuration of your computer. When the

driver install finishes, the FTDI CDM Drive Installation process completed message appears and you are prompted to “Press any

key to continue.” The installation of the Digital DrivePLUS Windows Setup Program Setup Wizard does not start until you press a key.

If after a few minutes, the message indicating the install is complete doesn’t appear and you still see the window as shown in Step 7, the

driver installation may need to be re-started. To re-start, first close the driver installation window. Next, eject the CD and go back to Step 4. 
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8) The Select Setup Language dialog window opens. Select an install language and then click OK.

9) The Velodyne Digital DrivePLUS Setup Program Wizard opens. Click Next to continue.
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10) Read the EULA (End User License Agreement), then select the I accept the agreement option. You have to accept the EULA to

continue with the software installation.

11) Click Next.

12) Browse to where you want to install the Digital DrivePLUS Windows Setup Program. The default location is your Windows

Program Files folder. 

13) Click Next.
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14) Browse to where you want the program to appear in your Start Menu. The default folder is Velodyne Digital DrivePLUS Setup.

15) Click Next.

16) If you don’t want the installation to create a desktop icon for the Digital DrivePLUS Windows Setup Program, un-check the Create

a desktop icon option. By default a desktop icon is created.

17) Click Next.
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18) Click Install.

19) If you want to run the Digital DrivePLUS Windows Setup Program now, select the Launch Velodyne Digital DrivePLUS Setup option.

20) Click Finish.
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21) You should now connect your Digital DrivePLUS subwoofer to the computer with the supplied USB cable, making the subwoofer is

powered on. This allows Windows to finish the driver installation.

22) You can now begin using the software to set the equalization parameters for your subwoofer. 

After the installation of the Virtual COM Port software, your computer thinks the USB cable from your computer to the Digital DrivePLUS is really

a serial cable connected to a COM port. 

You can see the COM port number assigned to the USB port by using the Windows Control Panel’s System > Hardware > Device Manager.

The virtual port appears as an additional COM port with the label "USB Serial Port." 

DIGITAL DRIVE PLUS WINDOWS SETUP PROGRAM USER INTERFACE
This section describes the controls and features available in the two user interface screens in the Windows Setup Program: 

• Frequency Response and Parameters screen

• Preset screen

Frequency Response and Parameters Screen

When you run the Digital DrivePLUS Windows Setup Program it opens to the Frequency Response and Parameters screen. This screen is the

screen you’ll use most often when optimizing the bass response.

The main functional areas of the screen are indicated in the following image.  The features available in each of these areas are described

after the image.

Figure 1: The Frequency Response and Parameters Screen
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Graphs

• Frequency Response Graph: Displays the measured frequency response. Both the horizontal and vertical scales are fixed.

• Parametric EQ Graph: Displays the graphical representation of the 8 adjustable parametric EQ filters based on the

Parametric Filter Settings.

- Each diamond represents one of the eight parametric filters. The small number by each        indicates the EQ number of the

parametric filter that diamond represents. 

- The filters are numbered 1 to 8 from left to right.

- The green line is the curve for a single parametric filter.

- The blue line is the summation of all parametric filter EQs.

- After one complete sweep tone, the frequency response updates.

- You can use the mouse to grab and drag the filter to a new frequency and level. Moving the diamond up and down changes the

level of boost or cut. Moving it side-to-side changes the frequency of the selected EQ filter. 

- Once a parametric filter’s EQ graph has a peak or dip, you see a horizontal line with small diamond handles appear through the

latest filter at the maximum or minimum level. Moving one of the diamonds at the end of this line towards the filter center diamond

raises the filter Q, narrowing the bandwidth. Moving it away from the filter center diamond widens the bandwidth lowering the Q.

- If you change a filter’s settings using this graph, the changes are shown in the Parametric Filter Settings area.

Optimization Parameters

• Parametric Filter Settings: Displays and allows you to adjust each of the parametric filter’s settings. You adjust the settings using

either single-increment mouse clicks or direct entry of a value. If you adjust a filter’s settings using these input fields, the changes

are reflected in the Parametric EQ Graph.

• Preset Parameter Settings: Displays and allows you to adjust the values of a selected preset with single-increment mouse clicks or

direct entry of a value.

EQ Optimization Option Selection and Initiation 

The options and buttons in this area allow you to select and start an optimization option for the connected subwoofer.

• Manual: Manual-EQ optimization.

• Auto: Auto-EQPLUS optimization.

• Self: Self-EQ optimization.

• Start: Begin the selected optimization.
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Save Setting Options

• Save to File: Save the current settings in the program to an EQ optimization profile file on your computer. Same as the File >

Save As menu selection.

• Save to DD+: Loads the current settings or loaded EQ optimization profile in the Digital DrivePLUS Windows Setup Program into the

Digital DrivePLUS subwoofer, memory but the subwoofer doesn’t reboot. You can save settings to the subwoofer even when the

subwoofer is not synced as long it is communicating with the Digital DrivePLUS Windows Setup Program.

• Reset: Reset all of the parametric filters to their factory default settings, which produces a flat line (level=0 dB, ISO frequencies,

Q=4.3) as the Parametric EQ Graph. ISO (International Organization for Standardization) frequencies are standard frequencies

used in the audio industry for EQ.

• Save and Exit: (Used in EQ process only) Saves EQ results to the subwoofer’s memory and then reboots the subwoofer.

• Exit without Saving (Used in EQ process only): Exit EQ mode without saving settings to a file or to the subwoofer.

Reboots the subwoofer.

Subwoofer Controls

• Mute: Mute the subwoofer to see the low end frequency response of the satellites of the audio system to which the

Digital DrivePLUS subwoofer is matched to. 

Status Information

• Filename/Connection (title bar): Shows the name of the settings file after it has been saved to the computer as well as

connection status of the subwoofer.

• Subwoofer/EQ (lower right): Displays the subwoofer connection as well as various status updates within the EQ

optimization processes.

Menu

• File Menu:

- Open: Open a subwoofer setup profile file.

- Save: Save a subwoofer setup profile file as a DDP file. 

- Save As: Save a subwoofer setup profile file with an additional name, or to a different place. 

- Exit: Close the program without saving settings to a file or to the subwoofer.

• DD+ Menu:

- Reconnect: Try to re-connect to the subwoofer.

- Save to DD+: Save the current settings to the connected subwoofer

- Restore Defaults: Restore the Digital DrivePLUS subwoofer to its factory default settings.

• Help Menu:

- About: Display the software Digital DrivePLUS Windows Setup Program version. You can use this to determine if you have the

latest version of the software that is available on the Velodyne website.

Screen Navigation

• Next: Allows you to open the Preset screen
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Preset Screen

The Preset screen allows you to view and modify the volume, low pass crossover frequency and slope, subsonic filter frequency and slope,

phase, and polarity of the presets including the Setup, or global, preset. The Preset screen also allows you to modify the contour frequency

and level, and servo gain for each preset. This screen also allows you to set the Night mode percentage and the auto-on setting.

Figure 2: The Preset Screen

• Screen Navigation:

- Previous: Allows you to return to the Frequency Response and Parameters screen.

Establishing Communication between the Digital DrivePLUS Subwoofer and the 

Digital DrivePLUS Windows Setup Program

1) Start the Velodyne Digital DrivePLUS Windows Setup Program using either the desktop shortcut icon              or selecting it from the

Windows Program menu.
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2) Connect your subwoofer’s front panel USB port to your computer using the supplied USB cable. Refer to the Digital DrivePLUS

User’s Manual for directions on how to remove the subwoofer’s front grille to access the USB port.

3) The program establishes communication with the subwoofer and indicates this by displaying Connected or Connected, Not Synced

in the program’s title bar and in the lower left corner of the window in the Subwoofer/EQ Status Line.

4) Once communication is established, the subwoofer model and serial number appear at the top of the Frequency Response

Graph area. 

5) Once you see the Connection message, you can use the program to control the subwoofer.

6) See the Troubleshooting section of this part of the manual if you don’t see the Connection message.

Refer to the Digital DrivePLUS User’s Manual for more information about the different optimization methods and setup options.

MAKING & SAVING PRESET CHANGES
The simplest customization of parameters you can do is to make and save changes to the presets. 

You can modify the preset parameters either in the Preset Parameter Settings area on the Frequency Response and Parameters screen

or on the Preset screen. The Preset screen has the advantage that you can see settings for all the presets at one time and also modify the

night mode and power on settings. The Frequency Response and Parameters screen has the advantage that you don’t have to open the

Preset screen.

See the Digital DrivePLUS User’s Manual for a detailed explanation of the preset parameter settings that you can modify.

To modify the presets using the Preset screen:

1) On the Frequency Response and Parameters screen, click Next (upper right hand corner).

• Some values are changed with pull-down menus, like the slopes, whereas others increment with up/down buttons.  

• The parameter input fields can also be selected with the mouse and the value typed into them.

2) Click Previous to return to the Frequency Response and Parameters screen.

3) Click Save to DD+ to save the preset setting changes to the subwoofer’s memory.

4) Click Save to File to save the preset changes to a file on your computer. Velodyne recommends this practice as a way to “back up

your work” and to be able to retrieve subwoofer settings without having the subwoofer connected to your computer. You can also save

the settings using the File > Save menu option. Previously saved profile files can be retrieved using the File > Open menu option.

To modify the presets using the Frequency Response and Parameters screen:

1) In the Preset Parameter Settings area use the Preset pull down menu to select which preset to modify.

2) Use the pull down menus to change the preset parameter settings.

3) Click Save to DD+ to save the preset setting changes to the subwoofer’s memory.

4) Click Save to File to save the preset changes to a file on your computer.

RUNNING SELF-EQ OPTIMIZATION– YOUR FIRST EQ

The easiest EQ optimization to perform is the Self-EQ. With Self-EQ the subwoofer generates its own sweep tone. 

To perform Self-EQ optimization:

1) Remove the microphone, mic cable and stand from the accessory kit. Carefully snap the microphone into the stand and attach the

larger end of the cable to it. See the Digital DrivePLUS User’s Manual for more information.

2) Place the microphone at the main listening position.

3) Attach the small end of the mic cable to the jack on the left side of the subwoofer front control panel.

4) Make sure the subwoofer is on and your audio system is off.
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5) On the Frequency Response and Parameters screen, select the Self option in the EQ Optimization Option Selection and

Initiation area.

6) Click Start.

7) The subwoofer produces its own sweep tone and its frequency response.

8) You can watch the subwoofer smooth its frequency response by adjusting the parametric EQ filter levels on the Frequency

Response and Parameters screen. Self-EQ doesn’t change the Setup preset parameters (volume, crossover, etc.) Self-EQ

uses a 160 Hz crossover.

9) When Self-EQ finishes, the front subwoofer display shows End for 10 seconds, then the subwoofer reboots by turning itself off and

back on. The display shows the preset number and then volume level. During this process the new filter settings are saved into the

subwoofer’s memory. 

10) Click Save to File to save the Setup preset’s EQ filter settings to a DDP file on your computer.

The frequency response curve is only saved with Manual-EQ, not Self-EQ or Auto-EQPLUS.

RUNNING AUTO-EQPLUS OPTIMIZATION – STEPPING UP IN POWER
The next level up in the Digital DrivePLUS EQ optimization methods is Auto-EQPLUS optimization. To perform Auto-EQPLUS optimization:

1) Set up the microphone as in the Self-EQ instructions above.

2) Make sure the subwoofer and your audio system are both on.

3) Place the Digital DrivePLUS Sweep Tone CD into your disc player and press play.

4) Once the sweep tone starts to play, adjust the receiver or processor output level to about the level of a normal-loudness conversation.

5) On the Frequency Response and Parameters screen, select the Auto option in the EQ Optimization Option Selection

and Initiation area.

6) Click Start.

7) The subwoofer not only adjusts the Setup preset EQ filter parameters as you watch, but it also adjusts the volume, crossover, slope,

and phase while these input fields are grayed out during the Auto-EQPLUS optimization process.

8) You can also watch the status of the subwoofer in the process down in the lower right in the subwoofer/EQ status line.

9) When Auto-EQPLUS optimization finishes, the front display shows End for 10 seconds, the subwoofer reboots by turning itself off

and back on. The display shows the preset number and then volume level. During this process the new filter settings are saved

into the subwoofer’s memory. When the subwoofer is rebooting, the Digital DrivePLUS Windows Setup Program shows the

subwoofer is Disconnected.

10) While the subwoofer is rebooting, shut off the Sweep Tone CD and remove it from the player.

11) When the subwoofer has finished rebooting, either the program and subwoofer reconnect automatically or you can

click DDPLUS > Reconnect in the menu. 

12) Click Save to File to save the Setup preset’s EQ filter settings to a DDP file on your computer. You will need it to

perform the following Manual-EQ optimization instruction.

The frequency response curve is only saved with Manual-EQ, not Self-EQ or Auto-EQPLUS.

RUNNING MANUAL EQ OPTIMIZATION – ADJUST IT TO YOUR LIKING
In some particularly problematic rooms, it may be necessary to employ even further adjustment than the Auto-EQPLUS. Manual EQ gives

enough flexibility to get the subwoofer response very flat:

1) Set up the microphone, subwoofer and Sweep Tone CD as in the Auto-EQPLUS optimization instructions.

2) Set the system playback volume level as in the Auto-EQPLUS optimization instructions.

3) On the Frequency Response and Parameters screen, select the Manual option in the EQ Optimization Option Selection

and Initiation area, then click Start.

4) Watch the subwoofer/EQ status line until it says Connected, Not Synced and then Syncing.
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5) When the subwoofer/EQ status line says Synced, start adjusting the subwoofer parameters. Do not attempt to adjust any settings

until the Subwoofer/EQ status line says Synced. Synced means the subwoofer has synchronized its frequency measurement with

the frequency of the sweep tone being played through your audio system.  An indication of not being synced is that you raise or lower

a filter slider and the response curve moves at another filter frequency.

6) Click Mute. You can now see the low frequency character of the satellites so that you can make a judgment about this crossover

frequency and slope to properly blend the Digital DrivePLUS subwoofer to them. 

7) Click Mute again to restore the subwoofer to playing.

8) Go to the File > Open menu option and open the file that you saved at the end of the Auto-EQPLUS optimization process. All the settings

shown in the Windows interface are reverted to those arrived at by the Auto-EQPLUS optimization.

9) Click Save to DD+. Now the Digital DrivePLUS subwoofer has been reset to its state at the end of the Auto-EQPLUS optimization. You can

save settings to the subwoofer even when the subwoofer is not synced as long it is communicating with the Digital DrivePLUS Windows

Setup Program.

10) Adjust the preset parameters as described in the Making & Saving Changes section. 

11) Adjust the parametric filter EQ parameters as described in the Graphs section above.

12) Click Save to DD+ to save the parametric filter settings to the subwoofer’s memory.

13) Click Save to File to save the parametric filter settings and the frequency response curve to a file on your computer. 

The frequency response curve is only saved with Manual-EQ, not Self-EQ or Auto-EQPLUS.

[ 16 ]

Digital DrivePLUS User Interface ManualWINDOWS INTERFACE FOR OPTIMIZATION



TROUBLESHOOTING GUIDE
This section includes information about how to fix issues you may have with the software and driver required to operate and optimize your

Digital DrivePLUS. If you can’t resolve your software issue using this section, please contact Velodyne customer service at (408) 465-2851 or

service@velodyne.com.

Issue: Can’t connect to subwoofer. 

Solution:

• Make sure subwoofer is on.

• Make sure USB cable is connected to both computer and subwoofer.

• Try plugging the USB cable into a different USB port on your computer.

• You may need to re-install the USB Virtual COM port driver. Re-insert the Velodyne Digital DrivePLUS Windows Setup Program CD into

your computer. You can cancel out of the install at the language selection prompt.

Issue: Windows still asks for USB drivers after running the program disc. 

Solution:

On your program CD is an archive file named “FTDI USB Driver XXXXXX”. The file XXXXXX is a numeric date. Copy this executable

file to your computer and extract the files. Direct the Windows hardware wizard to this extracted folder.

Issue: You hear an audible hum while your laptop is connected to the subwoofer through the USB port. 

Solution:

The hum is caused by the laptop power supply. The power supply doesn’t have a ground loop isolator, which means you can get cross-

talk noise/hum when any USB device, including the Digital DrivePLUS subwoofer, is connected to the power supply. To eliminate the hum:

• (Recommended) Disconnect the power supply and run the laptop on battery power when using the Windows Setup Program; or

• Plug the laptop into a 3-prong to 2-prong adapter and then into the power outlet.

UNINSTALLING VELODYNE’S DIGITAL DRIVE PLUS WINDOWS SETUP SOFTWARE
To uninstall the Velodyne Digital DrivePLUS Windows Setup Software, follow these steps:

1) With no programs running and all windows closed, go to the Uninstall Program feature of the Windows Control Panel. Each version of

the Windows operating system has a slightly different way to access the Control Panel and the Uninstall Program feature. Refer to the

Help system for your version of Windows to determine how to access the Control Panel’s Uninstall Program feature.

a. In Windows 7, go to the Windows Start Menu by right-clicking the         image usually found in the lower left corner in the

Windows toolbar. Your Windows toolbar may also be at the top or either side of your computer screen depending on

how you’ve set up your computer.

b. Select Control Panel from the popup menu.
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c. Click Uninstall a program under Programs.
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2) Scroll down to the “Velodyne Digital Drive PLUS Setup version X.XX” line and double-click it.

3) In the Velodyne Digital Drive PLUS Setup Uninstall dialog window, click Yes.

4) When the Windows uninstall wizard has finished, the Velodyne Digital DrivePLUS Windows Setup Program has been completely

removed from your computer.

UNINSTALLING THE VIRTUAL COM PORT SOFTWARE
You can leave the Virtual COM Port driver on your computer after you finish setting up your Digital DrivePLUS subwoofer. If you leave the Virtual

COM Port driver on your computer, you can more easily use the Windows Setup Software later to make changes to the Digital DrivePLUS

subwoofer parameters. You can leave it on even if you decide to uninstall the Digital DrivePLUS Windows Setup Program as it will give your

computer the ability to work with more USB devices that require a virtual COM driver.

However, if you need the hard drive space for other programs or files, you can uninstall the Virtual COM Port Software. If you uninstall the

Virtual COM Port software and want to modify Digital DrivePLUS subwoofer parameters, you need to re-install the Virtual COM Port software. 

Because port drivers go into the Windows Device Manager, not the Windows Program folder, the USB Virtual COM Port driver is uninstalled

in a different way than the Velodyne Digital DrivePLUS Windows Setup Program.
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To uninstall the USB Virtual COM Port driver:

1) Go to the System Device Manager feature of the Windows Control Panel. Each version of the Windows operating system has a slightly

different way to access the Control Panel and the System Device Manager feature. Refer to the Help system for your version of

Windows to determine how to access the Control Panel’s System Device Manager feature.

2) Click COM Ports in the Device Manager. 

3) Right-click on USB Serial Port. You must remove the COM Port driver before the Universal Serial Bus Controller driver or you won’t be

able to find the COM Port driver. 

4) Select Uninstall.

5) Go to the Universal Serial Bus Controllers listing and right-click on USB Serial Converter.

6) Click Uninstall.

7) To finish uninstalling the USB Virtual COM Port driver on Windows XP, you must remove the driver INF and PNF files manually. 

a. In the control panel go to Folder Options > View and select the Show hidden files in folders and display the contents of

system folders options.

b. Search the Windows/INF folder file for FTDIBUS.INF with the Word or phrase in the file option selected. This returns a file

named with the format of oem##.inf. Delete this oem##.inf file.

c. Search for the oem##.pnf file with the same number and delete it.

d. Search the Windows file for FTDIPORT.INF with the Word or phrase in the file option selected. This returns a file named with

the format of oem##.inf. Delete this oem##.inf file.

e. Search for the oem##.pnf file with the same number and delete it.

8) You have successfully removed the USB Virtual COM Port driver.
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PART TWO -  
TV Screen User Interface for Optimization

In order to use the TV Screen interface to perform any setup or optimization of your Digital DrivePLUS subwoofer, you need to connect

the video input on your TV to the video output of the subwoofer.

This part of this document covers:

• How to make the video connection between your TV and subwoofer.

• How to use the remote control to modify and save subwoofer parameters.

• How to run Self-EQ and Auto-EQPLUS optimization using the remote control.

• How to use the remote control to perform Manual-EQ optimization. 

Instruction Conventions

• Words in all uppercase bold letters in the setup instructions (e.g., SELECT, MENU, etc.) identify the specific remote button to be

pressed or selected, or the field (e.g., NEXT, SEL, etc.) on the screen you should select or should be paying attention to. 

• Words in title case and bold are the names of the interface screens, such as Introductory screen.

Make Video Connection between TV and Subwoofer

To make the video connection from the subwoofer to the TV:

1. Connect either:

The subwoofer’s Video Output (yellow RCA connector) to the TV’s composite video input (yellow connector).

OR

The subwoofer’s S-VIDEO output to the TV’s S-Video input.  

2. Use the TV’s remote to set the video input where you connected the video output as the active TV image. The Introductory screen

appears on your TV screen as shown in Figure 1.

See the Controls & Connections section of the Digital DrivePLUS User’s Manual for locations of these connectors on the subwoofer’s

back panel.

SCREENS
Following is an overview of the screens you use to optimize the subwoofer audio output.

Introductory Screen

When you first connect the video output of the subwoofer to your TV and turn on the power to both the TV and subwoofer, the Introductory

screen appears as shown Figure 1. If you use the remote to change settings, such as the selected preset or volume, the changes are

automatically reflected on this screen. This screen indicates that the subwoofer is in its Active mode. However, this screen can also be

used to indicate the subwoofer is in Runtime Inactive modes; screenshots are shown later in this section. See the Digital DrivePLUS

User’s Manual for description of the subwoofer modes. 

[ 21 ]

Digital DrivePLUS User Interface ManualPART TWO — TV SCREEN USER INTERFACE FOR OPTIMIZATION



Figure 1: Introductory Screen

On the remote, if you press MUTE to mute the subwoofer or NIGHT to go to night mode, these settings are also displayed on the

Introductory screen as shown in Figure 2.

Figure 2: Introductory Screen with Night Mode and Subwoofer Mute

The Introductory screen also shows the current power status – if 12V Trigger has been activated, if it has gone into Standby, or if it is

running in –Slave Mode–; screenshots are shown later in this section.
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SYSTEM RESPONSE SCREEN
From the Introductory screen you can get to the System Response screen which is used to display the frequency response graph for the

subwoofer’s output. See Figure 3. See the Remote Control Button Sequence Commands table on page 25 for the button sequence.

The System Response screen has the following information and features on it:

• A system response graph that shows the subwoofer’s low frequency output from 15 to 200 Hz. 

• A moving screen pixel marks on the frequency response curve the current frequency of the sweep tone that is playing. 

• 8 parametric filters each of which can be used at its current frequency or adjusted to a frequency and Q you desire between 15

and 200 Hz when in Manual-EQ mode. 

The filter level range is -13db to +6dB although the screen is only marked from -12dB to +6dB.

Status Messages

Status messages appear in the upper left hand corner of the TV screen. In Figure 3, the status message is LOW SIGNAL. The following

status messages appear in this position on the TV screen:

• MIC?: The subwoofer is receiving no signal from the microphone. Microphone is not connected, or either the microphone

or the cable is damaged.

• SYNCING: The subwoofer is trying to synchronize its frequency measurement with the frequency of the sweep tone being

played through your audio system. 

• SYNCED: The subwoofer has synchronized its frequency measurement with the frequency of the sweep tone being played

through your audio system.

• LOW SIGNAL: The receiver output level is too low to perform optimization. Turn up the receiver volume.  After 6 sweeps with

this condition, the subwoofer will reboot.

• HIGH SIGNAL: The receiver output level is too high to perform optimization. Turn down the receiver volume.

• VOL..: Auto-EQPLUS is adjusting subwoofer volume.

• CRS..: Auto-EQPLUS is adjusting subwoofer crossover frequency.

• SLP..: Auto-EQPLUS is adjusting subwoofer crossover filter slope.

• PHS..: Auto-EQPLUS is adjusting subwoofer phase. Auto-EQPLUS doesn’t adjust the polarity of the signal, but rather goes

right to adjusting the phase.

Screen Navigation

You can go to the System Settings screen using the NEXT option in the upper right hand corner of the screen. 

Figure 3: System Response Screen
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SYSTEM SETTINGS SCREEN
From the System Response screen you can get to the System Settings screen by selecting NEXT.

The System Setting screen has the following information and features on it:

• Display and modify the crossover filter, subsonic filter, phase, polarity, theater/music, volume, and other settings for each preset.

• The Setup preset is in the first column and is used to globally set the crossovers, slopes, phase, polarity, and volume for all presets.

Screen Navigation

You can go back to the System Response screen using the PREV option in the upper left hand corner of the screen. 

Figure 4: System Settings Screen

Screen Controls

You use the remote control to adjust the settings of the Digital DrivePLUS subwoofer. You perform all the setup functions using the buttons on

the Velodyne-supplied remote control and see the results on your TV screen. These controls are described later.

Tips for Using the TV Screen Controls

When using the on TV screen controls: 

• Remember to point the remote control at the subwoofer, not the TV.

• Use the s, t, and directional arrow buttons that surround the SELECT button to navigate the fields of the setup screens. 

• Settings are typically changed using the SELECT button, followed by the s and t buttons.

• Alternatively, the SET +/- buttons can be used to change settings.  

• A screen field highlighted in reverse video indicates your current location on the screen.  

• Holding down one of the s, t, and button causes the remote to repeat and you can then rapidly move through fields to arrive

at the desired one.

• You should be able to perform most of the setup process by using the s, t, and directional arrow buttons and

the SELECT button. 
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REMOTE CONTROL BUTTON COMMANDS
Following are commands and their remote control button sequences. Unless otherwise noted, these sequences work only on the

Introductory screen.

Remote Control Button Sequence Commands for TV-based Interface

Command Button Sequence Description

Go to System Response screen 1 – 2 – 3 – 4 – 5 On the Introductory screen

Self-EQ 3 – 2 – 1 Initiate Self-EQ optimization. Be sure to connect the

microphone before engaging. After 28 sweeps,

the unit saves and resets.

Cancel Self-EQ and Auto-EQPLUS RESET Stop and cancel a Self-EQ or Auto-EQPLUS

optimization process.

Restore defaults 8 – 9 – 0 Restore defaults and reset the subwoofer.

Restore last saved volume RESET If volume is changed, restores last saved volume.

Display serial number s - s - s - s - SELECT Shows the serial number of the unit at the top

of the screen.

Switch PAL/SECAM video t - t - t - t - RESET The unit restarts in PAL/SECAM video mode.

Use 8 -9- 0 (Restore defaults) to return to

NTSC mode.

Go to the System Response Screen

To get to the System Response screen:

1. With the Introductory screen showing on the TV, press 1-2-3-4-5 on the Digital DrivePLUS remote. As you press these buttons, the

numbers display on the Introductory screen as shown in Figure 5.

Figure 5: Introductory Screen
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2. After pressing 5, you see the System Response screen as shown in Figure 6.

Figure 6: System Response Screen

Go to the System Settings Screen

To get to the System Settings screen:

1. On the System Response screen, navigate the cursor to the NEXT field. 

2. Press SELECT on remote.

3. The System Settings screen appears as shown in Figure 7.

Figure 7: System Settings Screen
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Lock the Setup Preset

Before modifying any of the individual preset settings, lock the Setup preset. You can also lock the Setup preset to make sure it doesn’t get

changed after setting up your Digital DrivePLUS subwoofer. To lock the Setup preset:

1. On the System Settings screen position the cursor over UNLOCKED.

2. Press SELECT on the remote. 

3. LOCKED appears on the screen as shown in Figure 8.

Figure 8: System Settings Screen Lock Setup Preset

Restore Defaults

To restore the factory defaults for all the EQ settings:

On the Introductory screen, press 8-9-0 on the remote. The numbers won’t appear on the screen as you press them. If you are

successful, the screen flickers and then restores the Introductory screen; the DEFAULTS RESTORED message appears at the top

of the screen as shown Figure 9.

Figure 9: Introductory Screen Defaults Restored
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Save Settings

If you exit any EQ optimization without saving the settings, when the subwoofer power cycles, your settings return to what they were

previously. To save optimization settings:

1. Press the EXIT button on the remote, or position the cursor over the SAVE/EXIT field on either the System Settings screen

or the System Response screen.

2. The SAVE SETTINGS? prompt appears with YES selected as shown in Figure 10.

3. Press SELECT.

Figure 10: System Settings Screen Save Settings

• Selecting YES and then pressing SELECT on the remote button, saves your settings and reboots the subwoofer, returning

you to the Introductory screen. 

• Selecting NO and then pressing SELECT on the remote button, returns you to the Introductory screen without saving; the

previous settings saved in memory are used. 

• Selecting CANCEL and then pressing SELECT on the remote button, keeps you on the current screen.

4. While the subwoofer is saving its settings, you will see the video flicker and you may hear a slight pop from the subwoofer.

The subwoofer then displays the default preset and the volume. This is normal behavior.

Select a Preset

To select which preset you want to Manual-EQ, be sure to have the microphone connected to the subwoofer and the Sweep Tone CD in your

disc player and playing:

1. Position the cursor in a preset column (you cannot select the heading) on the System Settings screen.

2. Press TEST.

OR

1. Highlight the PRESET field on the System Response screen.

2. Use the SET +/- buttons on the remote to select a preset.

OR

1. Press a preset button on the remote on either the System Settings or the System Response screen. 
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Make & Save Preset Changes

The simplest customization of parameters you can do is to make and save changes to the presets. 

You can modify the preset parameters on the System Settings screen. 

See the Digital DrivePLUS User’s Manual for a detailed explanation of the preset parameter settings that you can modify.

1) Go to the System Settings screen.

2) Use the remote keys to make changes to the presets as shown in Figure 11.

3) Press TEST to review the curve with these settings active. Be sure to have the mic connected and the Sweep Tone CD playing first.

Figure 11: System Settings Screen Change Preset Low Pass Crossover Frequency

Change Default Preset 

The Default preset is invoked when the subwoofer powers on. The factory setting is preset 3 for the Default preset. To change the

default preset:

1. Use the s, t, and remote keys to select the current value for the DEFAULT PRESET as shown in Figure 12.

Figure 12: System Settings Screen Change Default Preset
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2. Push SELECT to be able to change the default preset.

3. Use the s or t remote keys to select the preset that you want as the default. Press SELECT.

4. Use the s, t, and remote keys to navigate to the SAVE/EXIT field and save per the Save Settings instruction above. 

Set Parametric Equalizer Filter Parameters

You can use the parametric equalizer parameters to achieve better room equalization. To use the parametric EQ feature: 

1. Go to the System Response screen. 

2. Position the cursor over the EQ slider box.

3. Press SELECT. The values for that particular EQ appear on the right hand side of the screen as shown in Figure 13.

Note:  If all you want to change is the level of each EQ, then you do not need to push SELECT. Simply push the s or t remote keys when

you are on the slider that you wish to change. The other EQ filter parameters will not show on the right. 

Figure 13: System Response Screen Modified 32 Hz EQ

4. To manipulate a parametric EQ, use:

• and     to move the frequency up and down

• SET + and SET – to change the Q value.  

• s and t to adjust the level of the EQ as before. 
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A selected EQ that has been moved with its level changed and Q adjusted is shown in Figure 14:

Figure 14: System Response Screen Modified 63 Hz EQ

5. To unselect the EQ, press SELECT again.

6. Use      and     to position the cursor on another EQ, if desired, and repeat Step 3, until the room is equalized. 

Note: Don’t put more than one EQ at one frequency. EQs can be close, but not stacked. If you find you need to stack the EQs at one

frequency in order to get enough output, you are probably working with a room mode. In this case, it is best to move the location of the

subwoofer or listening position instead.

Running Self-EQ Optimization – Your First EQ

The easiest EQ optimization to perform is the Self-EQ. With Self-EQ the subwoofer generates its own sweep tone. To perform

Self-EQ optimization:

1) Remove the microphone, mic cable and stand from the accessory kit. Carefully snap the microphone into the stand and attach

the larger end of the cable to it. See the Digital DrivePLUS User’s Manual for more information.

2) Place the microphone at the main listening position.

3) Attach the small end of the mic cable to the jack on the left side of the subwoofer front control panel.

4) Connect your subwoofer to your TV video input as described above in the Make Video Connection between TV and

Subwoofer section.

5) Make sure the subwoofer is on and your audio system is not playing any signal.

6) Press 3 – 2 – 1 on the remote to start Self-EQ; the System Response screen will display as well. The subwoofer’s front

display status message shows SE.

Once the Self-EQ process starts, you can press RESET on the remote to stop Self-EQ. If you exit back to the Introductory screen,

you can’t see the Self-EQ frequency response curve again.

7) On the System Response screen, SELF option shows in the EQ MODE area. 
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Figure 15: System Response Screen with Self-EQ Selected

8) You can watch the subwoofer smooth its frequency response by adjusting the parametric EQ filters on the System Response screen.

Self-EQ doesn’t change the Setup preset parameters (volume, crossover, etc.) and uses the crossover set to 160 Hz.

9) When Self-EQ finishes, the sweep tones stop, the front status message shows End for 10 seconds, the subwoofer reboots by turning

itself off and back on. The subwoofer display shows the preset number and then volume level. During this process the new filter

settings are saved into the subwoofer’s memory. 

Running Auto-EQPLUS Optimization – Stepping Up in Power

The next level up in the Digital DrivePLUS EQ optimization methods is Auto-EQPLUS optimization. To perform Auto-EQPLUS optimization:

1) Set up the microphone as in the Self-EQ instructions above.

2) Connect your subwoofer to your TV video input as described above in the Make Video Connection between TV

and Subwoofer section.

3) Make sure the subwoofer and your audio system are both on.

4) Place the Digital DrivePLUS Sweep Tone CD into your disc player and press play.

5) Once the sweep tone starts to play, adjust the receiver or processor output level to about the level of a normal-loudness

conversation at the mic.

6) Press and hold EQ on the remote until Auto-EQPLUS starts; you will see on the System Response screen the AUTO option in the

EQ MODE area. See Figure 16.

The Auto-EQPLUS proceeds until one of the following occurs:

• Auto-EQPLUS finishes successfully, saving the settings.

• You decide to quit, and press RESET on the remote. You exit back to the Introductory screen, you don’t see the Auto-EQPLUS

frequency response curve any more.

• You move the cursor off the AUTO field (in which case the field automatically reverts to Manual-EQ).

• The frequency response level is too high (peaks over 87 dB) or too low (average level below 70 dB).

• The Sweep Tone CD stops playing.

7) The Digital DrivePLUS subwoofer not only adjusts the Setup preset EQ filter levels as you watch, but it also adjusts the subwoofer level,

crossover, slope, and phase during the Auto-EQPLUS optimization process.

8) You can also watch the status messages during the process in the upper left hand corner of the TV screen.
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9) When Auto-EQPLUS optimization finishes, the front display status message shows End for 10 seconds, the subwoofer reboots by

turning itself off and back on. The display shows the preset number and then volume level. During this process the new filter

settings are saved into the subwoofer’s memory. 

10) While the subwoofer is rebooting, shut off the Sweep Tone CD and remove it from the player.

Figure 16: System Response Screen Auto EQPLUS Mode

Running Manual EQ Optimization– Adjust it to Your Liking

In some particularly problematic rooms, it may be necessary to employ even further adjustment than the Auto-EQPLUS. Manual EQ gives

enough flexibility to get the subwoofer response very flat:

1) Set up the microphone, subwoofer and Sweep Tone CD as in the Auto-EQPLUS optimization instructions.

2) Connect your subwoofer to your TV video input as described above in the Make Video Connection between TV and

Subwoofer section.

3) Set the system playback volume level as in the Auto-EQPLUS optimization instructions.

4) Push 1 – 2 – 3 – 4 – 5 on the remote.  If you are already on the System Response screen, select the MANUAL option in the

EQ MODE area.

5) Watch the status messages for SYNCING.

6) When the status message says SYNCED, start adjusting the subwoofer parameters. Do not attempt to adjust any settings until the

status message says SYNCED. SYNCED means the subwoofer has synchronized its frequency measurement with the frequency

of the sweep tone being played through your audio system.  An indication of not being synced is that you raise or lower filter slider

and the response curve moves at another frequency.  Also, the marker in the sweep tone (a small pop) occurs anywhere but at the

top of the graph.

7) Click Mute. You can now see the low frequency character of the satellites so that you can make a judgment about their roll-off

frequency and slope to properly blend to them with the Digital DrivePLUS subwoofer.

8) Click Mute again to restore the subwoofer to playing.

In Manual-EQ, if you press RESET on the remote, you are prompted if you want to save and exit, exit without saving, or to cancel

the exit action.

9) Adjust the preset parameters.

10) Adjust the parametric filter EQ parameters.

11) Save your changes as described in the Save Settings section. 
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Perform Listening Test

As a final thought on matching your Digital DrivePLUS subwoofer to your room, don’t forget the objective listening test. That is, make sure the

unit sounds good to you! Often, you may want to add a bit more bass than what would normally be considered flat even after you remove the

major peaks and valleys to achieve a flat frequency response. This is quite normal because human hearing rolls off rapidly below 100Hz,

causing the bass not to sound as loud. In order for the bass to sound flat to you, especially at lower levels, you may need to increase the

subwoofer volume in relation to the satellite speakers. An increase of about 2 dB to 8 dB is normal. 

To raise the subwoofer volume in relation to the satellites: 

• Raise the level for the subwoofer in the speaker level setup of your surround receiver or processor.

OR

• Raise the volume of your Digital DrivePLUS subwoofer after you have finished your room equalization and other settings. 

INTRODUCTORY SCREEN RUNTIME INACTIVE MODES
This section describes the appearance of the Introductory screen with various runtime messages that are shown when the subwoofer is

inactive.  In all cases, reactivating the subwoofer will take only a couple of seconds as the subwoofer starts up.

Standby Mode

Figure 17 shows the message displayed when the Standby feature is engaged. The subwoofer enters Standby mode if this mode is set to

ACTIVE in the System Settings screen, saved, and has not had any input signal for 10 to 15 minutes.

Figure 17: Introductory Screen Standby Mode Active
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Power Off Mode

Figure 18 shows the message displayed when the       on the remote is pressed, powering down the subwoofer. When in this mode,

press       to reactivate the unit.

Figure 18: Introductory Screen Power Off Mode Active

Waiting for 12 Volt Trigger Mode

Figure 19 shows the message displayed when the unit is waiting for a 12 Volt trigger to activate after the AUTO ON/OFF MODE is set to

12V TRIGGER operation on the System Settings screen and saved.

Figure 19: Introductory Screen Waiting for 12 Volt Input
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Defeat Subwoofer’s Low Pass Crossover Filter

In rare cases you may want to permanently defeat the subwoofer’s low pass crossover. For example, if you have not performed Auto-EQPLUS,

the subwoofer’s input from the receiver is limited by the receiver’s internal crossover to the bass frequencies, or you simply would rather not

use the subwoofer’s crossover filter. To defeat the low pass crossover:

1. Navigate to the System Settings screen.

2. Move the cursor down to LOW PASS XOVER FREQ and push SELECT.

3. Press RESET.

4. The screen shown in Figure 20 appears.

5. Exit and save per the Save Settings instruction above. 

Figure 20: System Settings Screen Defeating Subwoofer’s Low Pass Crossover Filter
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PART THREE -  
Software & Driver Updates

Software updates and installation instructions for the USB Virtual COM Port driver, the Velodyne Digital DrivePLUS Windows Setup Program,

and the Velodyne Digital DrivePLUS subwoofer firmware can all be found at www.velodyne.com. 

The Velodyne Digital DrivePLUS subwoofer firmware updates are applicable regardless of whether any of the user interfaces are used or not.

All firmware update instructions are included with the updates on the Velodyne website. When updating, be sure to read ALL readme.txt files

and other instruction at the Velodyne website to make sure that you update the software correctly.

The Digital DrivePLUS subwoofer firmware is updated through an RS-232 EXTENSION cable. A null modem or crossover cable will not work.

Be sure that you have an extension cable before you attempt to update these. The USB Virtual COM Port driver and the Velodyne Digital

DrivePLUS Windows Setup Software only update through the controlling Windows computer, so no attachment is necessary to the subwoofer

for their updates and no changes are made to the subwoofer by these updates.
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